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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2018 Schneider Electric. All rights reserved.
2 33003805 12/2018



Table of Contents
Safety Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
About the Book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Chapter 1 Unity Loader General Information. . . . . . . . . . . . . . . . . . 11
General  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Preconditions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Chapter 2 Communication. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Target Devices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Chapter 3 Unity Loader Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . 17
General Description of the Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . 18
Project Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Firmware Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Save on Memory Card. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Options Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
About Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Scan Network Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Transferring Data Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Chapter 4 Example: Transfer of an Application from PC to PLC. . . 49
Transfer of an Application from PC to PLC  . . . . . . . . . . . . . . . . . . . . 49

Appendices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Appendix A Transfer of Applications in Batch Mode  . . . . . . . . . . . . . 53

Batch Mode with the Unity Loader Command Line Interface  . . . . . . . 53
Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
33003805 12/2018 3



4 33003805 12/2018



Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
6 33003805 12/2018



Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.
NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
8 33003805 12/2018



About the Book
At a Glance

Document Scope
This document describes the Unity Loader stand-alone tool.
Unity Loader can transfer Control Expert, Unity Pro applications bidirectionally between a PC and 
a Modicon M340, M580, Momentum, Premium or Quantum PLC.
NOTE: Unity Pro is the former name of Control Expert for version 13.1 or earlier.
It also transfers firmware (FW) mono-directionally from a PC to a Modicon M340, M580, or 
Momentum PLC or to Modicon X80 and eX80 modules containing firmware.
Complementary information on firmware update procedures and firmware compatibility rules is 
available in the Control Expert online help or in dedicated documents listed in the table below 
(see page 10).

Validity Note
This documentation is valid for Unity Loader V14.0 or later.
33003805 12/2018 9



Related Documents

You can download these technical publications and other technical information from our website 
at www.schneider-electric.com/en/download.

Title of documentation Reference number
Firmware Compatibility Rules, Modicon M580, Modicon Momentum, and 
Modicon X80 I/O Modules

EIO0000002634 (English)

Modicon M340, Update Procedure, User Guide EIO0000002382 (English)
Modicon M580, Update Procedure, User Guide EIO0000002383 (English)
Modicon Quantum, Update Procedure, User Guide EIO0000002381 (English)
Modicon Controllers Platform Cyber Security, Reference Manual EIO0000001999 (English), 

EIO0000002001 (French), 
EIO0000002000 (German), 
EIO0000002002 (Italian), 
EIO0000002003 (Spanish), 
EIO0000002004 (Chinese)

EcoStruxure™ Control Expert, Operating Modes 33003101 (English), 
33003102 (French), 
33003103 (German), 
33003104 (Spanish), 
33003696 (Italian), 
33003697 (Chinese)
10 33003805 12/2018
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Chapter 1
Unity Loader General Information

Overview
This chapter comprises general information about the Unity Loader and the dedicated hardware 
platforms Modicon M340, M580, Momentum, Premium, and Quantum.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
General 12
Installation 13
Preconditions 14
33003805 12/2018 11



General Information
General

Overview
The Unity Loader is a stand-alone software tool dedicated to the M340, M580, Momentum, 
Premium, and Quantum hardware platforms.
A Control Expert or Unity Pro license is not required to use the loader.
The Unity Loader software provides the following transfer features:
 transfer of a Control Expert application from a PC to a Modicon M340, M580, Momentum, 

Premium, or Quantum PLC.
 transfer of a Control Expert application from a Modicon M340, M580, Momentum, Premium, or 

Quantum PLC to a PC.
 transfer of firmware (FW) from a PC to a Modicon M340, M580, or Momentum PLC or to 

Modicon X80 and eX80 modules containing firmware.
Refer to Firmware Compatibility Rules, Modicon M580, Modicon Momentum, and Modicon X80 I/O 
Modules for additional informations.
The Unity Loader software requires one of the following operating systems:
 Microsoft Windows 7 Professional 32-bit / 64-bit
 Microsoft Windows 10 Pro 32-bit / 64-bit
 Microsoft Windows Server 2016 Standard 64-bit
12 33003805 12/2018



General Information
Installation

Overview
If you have:
 the packaged distribution of Unity Loader, the installation software is on the installation media 

in your package.
To start the installation, click D:\setup.exe, where D: is the drive letter for your CD/DVD drive.

 the electronic distribution, the installation software is included in the file you downloaded.
Browse to the directory where you saved the downloaded file and either decompress the file or 
make a CD. Start the installation.

When you start the installation, the Unity Loader Installation Wizard guides you through the rest of 
the installation.

Cyber Security
Please refer to the Modicon Controllers Platform Cyber Security, Reference Manual.

Password Management
Please refer to the EcoStruxure™ Control Expert, Operating Modes help for more details about 
Password Management.
33003805 12/2018 13



General Information
Preconditions

Before FW Transfer
NOTE: Save the PLC program and other data before transferring firmware (FW) from a PC to a 
PLC or to a module with firmware.

PLC in Stop Mode
Stop the PLC before you start firmware (FW) transfer.
If you do not stop the PLC before trying to transfer firmware (FW), you are informed by the 
Unity Loader that the PLC has to be stopped.
After confirming this message, the Unity Loader stops the PLC automatically.
NOTE: A firmware (FW) transfer is only possible on a Modicon M340, M580, or Momentum 
hardware platform. Refer to Firmware Compatibility Rules, Modicon M580, Modicon Momentum, 
and Modicon X80 I/O Modules.

WARNING
UNINTENDED EQUIPMENT OPERATION
Before transferring firmware to a PLC or to a module with firmware make sure that you have 
selected the correct project and firmware files and entered the correct target address. Verify the 
address by comparing the MAC address printed on the device with the MAC address shown in 
the Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
14 33003805 12/2018



Unity Loader
Communication
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Chapter 2
Communication

Target Devices

Overview
The Unity Loader target devices are as follows:
 processors (CPUs) of the Modicon M340 platform
 processors (CPUs) of the Modicon M580 platform
 processors (CPUs) of the Modicon Momentum platform
 processors (CPUs) of the Modicon Premium platform
 processors (CPUs) of the Modicon Quantum platform
 Modicon X80 and eX80 modules containing firmware
 BME XBP •••• Ethernet backplanes

Run/Stop Command
The Unity Loader can send a run or stop command to the processor.

WARNING
UNINTENDED EQUIPMENT OPERATION
Before starting/stopping a PLC, make sure that you are connected to the correct target address. 
Verify the address by comparing the MAC address printed on the device with the MAC address 
shown in the Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Evaluate operational state of equipment before starting or stopping a PLC.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
33003805 12/2018 15



Communication
Communication
Communication for CPUs and modules:
 M340 and M580 CPUs are accessible through their USB or Ethernet ports.
 Momentum CPUs are accessible through their USB or Ethernet ports when available.
 Premium CPUs are accessible through their Uni-Telway (UNTLW) ports.
 Quantum CPUs are accessible through their Modbus ports.
 M340 or M580 Ethernet modules are accessible through their own Ethernet port (crossover 

cable, point to point).
 X80 and eX80 modules containing firmware are accessible through the CPU (connection on a 

CPU port).
These modules can be accessed through USB or Ethernet ports.

 BME XBP •••• Ethernet backplanes are accessible through the USB or Ethernet ports of the 
M580 BME P58 •040 CPU, or Ethernet ports of a BME CRA ••• •• adapter modules mounted on 
the backplane.
16 33003805 12/2018
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Chapter 3
Unity Loader Dialog Box

Overview
This chapter comprises information about the tabs of the Unity Loader dialog box.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
General Description of the Dialog Box 18
Project Tab 24
Firmware Tab 31
Save on Memory Card 36
Options Tab 39
About Tab 41
Scan Network Dialog Box 43
Transferring Data Dialog Box 45
33003805 12/2018 17



Unity Loader Dialog Box
General Description of the Dialog Box

Overview
The user interface of the Unity Loader is a dialog box with 4 different tabs:
 Project tab

transfer of a Control Expert application (program, data, user files) from a PC to a PLC or vice 
versa

 Firmware tab
transfer of firmware (FW) from a PC to a PLC or to a module with firmware

 Options tab
general settings for the Unity Loader

 About tab
information about your Unity Loader (version, copyright, etc.)

Transfer FW or Transfer Project

WARNING
UNINTENDED EQUIPMENT OPERATION
Before transferring data to a PLC or to a module with firmware make sure that you have selected 
the correct project and firmware files and entered the correct target address. Verify the address 
by comparing the MAC address printed on the device with the MAC address shown in the 
Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Unity Loader Dialog Box
Start PLC / Stop PLC

Launching the Unity Loader
Launch the Unity Loader via Start → All Programs → Schneider Electric → Unity Loader.

WARNING
UNINTENDED EQUIPMENT OPERATION
Before starting/stopping a PLC make sure that you are connected to the correct target address. 
Verify the address by comparing the MAC address printed on the device with the MAC address 
shown in the Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Evaluate operational state of equipment before starting or stopping a PLC.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
33003805 12/2018 19



Unity Loader Dialog Box
General Structure
The following areas are included in each of the 4 tabs:
 tab selection (at the top of the dialog box)
 tab specific area
 Connection
 Memory Card

NOTE: If Unity Loader is connected to a CRA module, an M580 CPU or a Momentum CPU the 
caption Memory Card is changed to Internal Memory.

 command buttons (at the bottom of the dialog box)
After launching Unity Loader, the dialog box opens with the Project tab.

Tab Selection
To select a tab click the respective tab selector (Project, Firmware, Options, About).
20 33003805 12/2018



Unity Loader Dialog Box
Tab Specific Area
The content of the tab-specific area depends on the individual tab. For more information, see the 
respective tab description:
 Project
 Firmware
 Options
 About

Connection
NOTE: If Unity Loader is connected to an Ethernet Remote I/O header (BMX CRA 312 •• or 
140 CRA 312 ••), few information is different compared to standard CPU. It is not possible to start 
or stop this module as it does not contain an application. For this reason it is also not possible to 
transfer applications or application-related data.
The connection area comprises the following elements:

NOTE: Devices are addressed by TCP/IP addresses, Modbus addresses, Uni-Telway addresses 
or through point-to-point connection via USB (default). The address can either specify a CPU or an 
Ethernet module.

Element Description
Media This list box displays one of the 4 possible connections:

 Ethernet
 USB (default)
 UNTLW
 Modbus

To select a connection, click the arrow and select the respective connection in the list.
Address: This list box displays the address of the target device e.g. SYS (USB or UNTLW), 

139.158.105.141 (Ethernet or Modbus TCP) or 31 (Modbus).
To select another address, click the arrow and select the respective address in the list, or 
type the address you want to connect to.

PLC: This box indicates the state of the PLC:
 RUN
 STOP
 HALT
 LOADING
 NOCONF
 ERROR
33003805 12/2018 21



Unity Loader Dialog Box
Memory Card
The memory card area comprises the following elements:

The following data are stored in the file system partition of the memory card on the Modicon M340 
or M580 hardware platform:
 User Web Files (CPUs with Ethernet and NOEs)
 the Factory Cast default Web site
 potentially custom web pages
 some user files relative to the Web site

 Data Storage
 user files managed by the application with the file management function blocks or
 files transferred by the user with FTP

 Firmware (FW)
files transferred by the Unity Loader for FW update (upgrade or downgrade).

NOTE: If no memory card is installed in the M340 PLC, the firmware (FW) cannot be transferred 
to the M340 PLC, because the FW is temporarily stored on the memory card.
NOTE: User Web Files are not supported for the M580 hardware platform.
NOTE: The Free Space shown for Memory Card is relative to the whole file system partition. 
Please refer to the memory card characteristics to see what is the size that can be allocated to the 
user files. FW update is not possible in case of insufficient free space.
Note: The memory card at the Premium hardware platform is structured in the following way:
 Program and symbols
 Constants
 Additional data storage

Element Description
State: This box indicates the state of the memory card installed in the connected module:

 OK
 Absent
 Read only
 Access error

Free Space: This box indicates the free space available on the memory card file system partition of the 
connected PLC.
22 33003805 12/2018



Unity Loader Dialog Box
Command Buttons
The text of some buttons changes depending on the actual situation (e.g. Connect/Disconnect). 
Grayed buttons are disabled.
The command button area comprises the following buttons:

Help Button
NOTE: There is no Help button available in the dialog box. To launch online help press F1 or click 
the  button in the title bar.

Button Description
Scan... Click this button to open the Scan Network dialog box. Network scanning is used to detect 

IP addresses available in the network. For more information refer to Scan Network Dialog 
Box (see page 43).

Connect / 
Disconnect

Click this button to connect/disconnect the Unity Loader to/from the selected PLC.

PC<=>PLC Click this button to select the data transfer from PC to PLC or from PLC to PC, depending 
on the selected transfer direction. The current transfer direction is indicated by transfer 
signs (arrows) in the tab-specific area of the Project tab and the Firmware tab. The transfer 
direction can only be selected for the 3 transfer signs (arrows) at the same time.
Note: It is not possible to transfer the FW from PLC to PC. For the Firmware tab the 
PC<=>PLC button is disabled.

Transfer Click this button to start the transfer between the PC and the PLC. The transfer direction 
depends on the previous executed selection. The Transferring data dialog box opens (refer 
to the Transferring Data Dialog (see page 45)).

Start PLC / Stop 
PLC

Click this button to start/stop the PLC (see page 19).
NOTE: If Unity Loader is connected to a CRA module the button Start PLC / Stop PLC is 
disabled.

Close Click this button to close the Unity Loader dialog box.
The Close button is disabled during transfer.
33003805 12/2018 23



Unity Loader Dialog Box
Project Tab

Overview
This tab comprises the following services:
 project transfer
 transfer of a Control Expert application from a PC file (*.STU, *.STA, *.STM) to a PLC
 transfer of a Control Expert application from a PLC to a PC file (*.STA, *.STM)

 project data transfer
 save application data values from a PLC to a PC file (*.DAT)
 restore application data values from a PC file (*.DAT) to a PLC

 project files transfer
 save user files (data storage files and/or user files in the embedded Web site) from a PLC to 

a PC file (*.CAR)
 restore user files from a PC file (*.CAR) to a PLC

Main Parts
The specific area of the project tab consists of 2 main parts:
 PC Project properties on the left specify the content of the files stored on the PC.
 PLC Project properties on the right specify the current status of the files stored on the connected 

PLC.
The transfer signs (arrows) between the 2 property areas indicate the transfer direction and 
significant comparison results between PC project and PLC project.
24 33003805 12/2018



Unity Loader Dialog Box
Representation
After launching Unity Loader, the dialog box opens with the Project tab.

NOTE: 
If Unity Loader is connected to a CRA module it is not possible to transfer:
 PC Project
 PC Project Data
 PC Project Files
Therefore the check boxes are disabled and direction arrows are crossed.
33003805 12/2018 25



Unity Loader Dialog Box
PC Project Properties
The PC Project section consists of the following elements:

Element Description
PC Project The list box at the top displays the current project file with its path.

To select a prior transferred project file click the arrow and select the respective project file.

To select any other project file click the ... button ( ). This opens the dialog box Select 
application file where you can select the desired Control Expert project file.
Further project file information:
 Name: name of the Control Expert project (default is STATION)
 Last Build: date and time of the last Control Expert project build
 Version: version of the Control Expert project

PC Project 
Data

The list box at the top displays the current project data file with its path.
To select a prior transferred project data file click the arrow and select the respective project 
data file.

To select any other project data file click the ... button ( ). This opens the dialog box Select 
a data file where you can select the desired Control Expert project data file.
Further project data file information:
 Name: name of the Control Expert project data file
 Last Build: date and time of the last Control Expert project build
 %M: located variables (bits)
 %MW: located variables (words)
 Unlocated Data: data of function blocks and application

PC Project 
Files

The list box at the top displays the current project files archive with its path.
To select a prior transferred project files archive click the arrow and select the respective 
project files archive.

To select any other project files archive click the ... button ( ). This opens the dialog box 
Select a storage file where you can select the desired Control Expert project files archive.
Note: The project files archive (*.CAR) is a backup file only and can not be edited with other 
tools.
The following files are stored as parts of the *.CAR file, if existent on the PLC:
 User Web Files: user Web files stored on the memory card of the M340 PLC
 Data Storage: user files stored on the memory card of the M340 PLC via special function 

blocks
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Unity Loader Dialog Box
PLC Project Properties
The PLC Project section consists of the following elements:

Enable Transfer (Check Boxes)
The specific area of the project tab provides the possibility to transfer 3 different parts of a 
Control Expert project:
 project (*.stu, *.sta, *.stm)
 project data (*.dat)
 project files (*.car)
By default the 3 parts are selected, which allows a transfer of a project in one operation.
Each part of a project can be excluded from transfer by clearing the respective Enable Transfer 
check box. A deselected part is grayed and its transfer sign (arrow) is red and crossed out.
Even for excluded parts the available information is displayed to provide the context information.
NOTE: For the following reasons, the check boxes are disabled and the color of the arrows is 
switched to red:
 invalid files (e.g. files not created with Control Expert, but with valid extension)
 PLC in NOCONF state (not configured)
 file not supported by the hardware platform (*.car is not supported by the Premium CPU)

Element Description
PLC Project Enable Transfer see below.

Project file information:
 Name: name of the Control Expert project (default is STATION)
 Last Build: date and time of the last Control Expert project build
 Version: version of the Control Expert project

PLC Project 
Data

Enable Transfer see below.
Project data file information:
 %M: located variables (bits)
 %MW: located variables (words)
 Unlocated Data: data of function blocks and application

PLC Project 
Files

Enable Transfer see below.
The following files are stored as parts of the *.CAR file, if existent on the PLC:
 User Web Files: user Web files stored on the memory card of the M340 PLC
 Data Storage: user files stored on the memory card of the M340 PLC via special function 

blocks
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Unity Loader Dialog Box
Transfer Signs (Arrows)
Transfer signs (arrows between the PC´s and PLC´s property areas) indicate:
 the transfer direction
 significant comparison results between the PC and the PLC projects
The transfer direction can be changed by clicking the PC<=>PLC button. The transfer direction can 
only be changed for the 3 signs (arrows) at the same time.

Comparison Results
Comparison is only done for transfer from PC to PLC.
The comparison results are represented by different colors of the arrows:
 Green indicates that these parts of the PC and the PLC projects are compatible.
 Yellow indicates that these parts are partially compatible but a faultless transfer cannot be 

assured.
 Red indicates that these parts are not compatible. In this case the transfer sign is additionally 

crossed out.
NOTE: If the Unlocated Data part is not compatible with the project embedded inside the PLC, only 
the located variables (%M, %MW) are transferred. A message is displayed and the arrow color 
switches to yellow.

Transfer from PLC to PC
NOTE: For transferring a project from PLC to PC no comparison is done and therefore color 
indication is not available. If you try to transfer a file that already exists, you have to confirm to 
overwrite it.
If you transfer a project from PLC to PC the appropriate boxes at PC side (PC Project, PC Project 
Data, PC Project Files) are filled automatically by the Unity Loader:
 If a history exists for the selected project, the boxes are filled with historic input.
 For new projects the names are generated from the Default backup directory (to be set on the 

Options tab) and the project name on PLC.
If, for example, the project name on PLC is Motor_01 and the default backup directory is 
C:\Applications, the following names are generated:
 PC Project: C:\Applications\Motor01.sta
 PC Project Data: C:\Applications\Motor01.dat
 PC Project Files: C:\Applications\Motor01.car

Entering File Names
The dialog box supports you in entering file names:
 If you already specified names, the respective boxes are automatically filled with historic input.
 If you enter new names in one of the list boxes, a proposed entry is automatically entered in the 

next list box. Example: If you enter C:\Applications\Motor_01.stu in the PC Project box and you 
click the empty PC Project Data box afterwards, it fills it automatically with 
C:\Applications\Motor_01.dat. You can confirm this proposal or overwrite it.
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File Format

To transfer a project from PC to PLC you can select a file in one of the three formats.
Unity Loader stores a project, transferred from PLC to PC in *.STA or *.STM format, depending on 
the project settings in Control Expert (Upload Information Include/ Without Upload Information). 
More details are provided in following tables.
NOTE: The Control Expert project has to be generated in Standard Mode. If a project generated 
in Simulation Mode is transfered from the PC to the PLC, a detected error is reported.
Upload Information Included

File 
Format

Description Comment

*.STU Control Expert project file project including source code and Control Expert 
workspace data

*.STA Control Expert archive 
file

project including source code but without 
Control Expert workspace data
This archive file is very compressed.

*.STM Unity Loader specific 
project file

binary project data only, required for execution on PLC
It contains no source code and can therefore not be 
read by Control Expert. 
Note: This file format can be used to backup the PLC 
project data.

Control Expert  Unity Loader  PLC
Via Tools → Project Settings → 
General → PLC embedded data 
the check box Upload Information 
is selected.
A project is saved/archived in 
*.STU or *.STA format

-> Such a binary project can be 
transferred to PLC with the 
Unity Loader.

-> The binary project runs on the 
PLC.

Such a file in *.STA format can be 
opened with Control Expert (but 
without the former workspace 
data.)

<- Such a binary project can be 
transferred from PLC to PC with 
the Unity Loader and is saved in 
*.STA format.

<- The binary project runs on the 
PLC.
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Without Upload Information

NOTE: To save space on the PLC, it is recommended not to select the check box Upload 
Information.
For detailed information about *.STA format and Upload Information please refer to EcoStruxure™ 
Control Expert, Operating Modes

File Format After Online Modification
Online modifications of a project via Control Expert can result in *.STM file format:
 In Control Expert you built a project with the check box Upload Information selected.
 With Unity Loader you transferred such a binary project to PLC.
 With Control Expert you online modified the program in the PLC.

(The upload information is no longer up-to-date).
NOTE: Only Control Expert or Unity Loader can be connected to a PLC at a time.
 Now you try to disconnect the PLC from Control Expert and a dialog box informs you, that the 

upload information is not up-to-date.
 If you confirm to update the upload information (with Yes) it is updated.
 If you negate to update the upload information (with No) it is not updated.
 Trying to transfer such a not updated project from PLC to PC with the Unity Loader, you are 

informed that the upload information is not up-to-date and the project is stored in *.STM format.

Control Expert  Unity Loader  PLC
Via Tools → Project Settings → 
General → PLC embedded data 
the check box Upload Information 
is not selected.
A project is saved/archived in 
*.STU or *.STA format

-> Such a binary project can be 
transferred to PLC with the 
Unity Loader.

-> The binary project runs on the 
PLC.

Such a file in *.STM format can not 
be opened with Control Expert.

<- Such a binary project can be 
transferred from PLC to PC with 
the Unity Loader and is saved in 
*.STM format.

<- The binary project runs on the 
PLC.

- - A file in *.STM format can be 
transferred from PC to PLC with 
the Unity Loader.

-> The binary project runs on the 
PLC.
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Firmware Tab

Overview
This tab comprises the following services:
 immediate firmware (FW) update (upgrade or downgrade) of the target device (CPU, NOE, or 

other modules with firmware)
 generating a memory card to be used later for firmware update of another PLC (Modicon M340 

only)
NOTE: A firmware (FW) transfer is only possible on a Modicon M340, M580, or Momentum 
hardware platform. Refer to Firmware Compatibility Rules, Modicon M580, Modicon Momentum, 
and Modicon X80 I/O Modules.

Main Parts
The specific area of the Firmware tab consists of 2 main parts:
 PC firmware properties on the left specify the content of the files stored on the PC.
 PLC firmware properties on the right specify the content of the files stored on the PLC.
The transfer sign (arrow) between the 2 property areas indicates the transfer direction and 
significant comparison results between PC and PLC firmware (FW).
NOTE: It is not possible to transfer FW from PLC to PC.

Precondition
If no memory card is installed in the Modicon M340 PLC, the firmware (FW) cannot be transferred 
to the M340 PLC because the FW is temporarily stored on the memory card.
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Representation
Firmware tab

PC FW Properties
The PC firmware (FW) properties area consists of the following elements:

Element Description
PC The list box at the top displays the selected FW file with its path.

To select a prior transferred FW file, click the arrow and select the respective FW file.
To select any other FW file, click the ... button ( ). This opens the dialog box Select a 
Firmware File where you can select the desired FW file.
Further information:
 Device: name of the device
 Version: version of the FW
 Description: description of the FW
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PLC FW Properties
The PLC firmware (FW) properties area consists of the following elements:

Firmware (FW) Information
There may be more than 1 FW to be displayed and compared for 1 device. This information is 
displayed in additional rows.
By default, main information (device name and version) is displayed. Use the horizontal scroll bar 
to display the entire information.
Position the mouse pointer on a listed FW to display the related information (tooltip).

MAC Address
The MAC address is displayed for Ethernet devices.
This helps you to identify the device more securely.
The MAC address is not available for intelligent modules (see below).
NOTE: If Unity Loader is connected to a CRA module, the MAC address of the CRA is displayed 
in the MAC address field.

Hardware ID
The hardware ID must match. If not, the transfer sign is marked red and crossed out. Transfer is 
disabled.

FW Version
The firmware (FW) version to be transferred should be later than the current one. If not, the transfer 
sign is marked yellow.

Transfer Sign (Arrow)
Transfer sign (arrow between the PC and PLC property areas) indicates:
 the transfer direction
 significant comparison results between the PC and the PLC firmware

Element Description
PLC  Device: name of the device

 Version: version of the FW
 Description: description of the FW
 MAC Address: MAC address of the PLC
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Comparison Results
Comparison is only done for transfer from PC to PLC.
The comparison results are represented by colors:
 Green indicates that the firmware of the PC and the PLC are compatible.
 Yellow indicates that the firmware of the PC is earlier than or partially compatible with the 

firmware of the PLC.
 Red indicates that the firmware of the PC and the PLC are not compatible. In this case, the 

transfer sign is additionally crossed out.

FW Partial Transfer
If not all parts inside the selected firmware file (*.ldx) are compatible, the Unity Loader offers a 
partial download of the compatible firmware parts.
Confirm the popup message that is displayed to make a partial download.

FW Transfer from PLC to PC
It is not possible to transfer the firmware from PLC to PC.
In the Firmware tab, the PC<=>PLC button is disabled.

Addressing Modules
The Module check box enables you to update other modules (with firmware) of the Modicon M340 
or M580 hardware platform (for example, BMX ART 0414):

Step Action
1 Activate the Module check box to display Rack.Slot of the device connected via Ethernet (for 

example, 0.6).
2 Click the ... button ( ) right beside the Module check box to open the Module Address dialog 

where you can enter Rack Index and Slot Index of the module you want to update.
3 Enter Rack Index and Slot Index and then clicking OK.
4 Now you can update the specified module.
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Constraints for Updating Modules
Refer to Firmware Compatibility Rules, Modicon M580, Modicon Momentum, and Modicon X80 I/O 
Modules.
The following constraints apply to the updating modules feature:
 M340 or M580 Ethernet modules can be updated by direct connection only (same as for CPUs).
  Modicon X80 and eX80 modules are accessible through the CPU (by a connection on a CPU 

port). These modules cannot be accessed through Ethernet modules.
 Updating a CRA adapter can be done through 1 of the following:
 connection to the service port of the corresponding Quantum CRP module using the IP 

address of the CRA adapter
 connection to an Ethernet port on an M580 CPU
 connection to the service port of the CRA adapter itself

 After updating the firmware of a module, the firmware version displayed in Unity Loader is not 
refreshed automatically.
To display the firmware properties after updating either:
 perform a hardware reset of the PLC by pressing the reset button of the power supply 
 by power cycling the PLC

NOTICE
INOPERABLE EQUIPMENT
To avoid that a module remains blocked in a non-operational state after updating the firmware 
using the Save on Memory Card feature either:
 perform a hardware reset of the PLC by pressing the reset button of the power supply
 power cycle the PLC
Failure to follow these instructions can result in equipment damage.
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Save on Memory Card

Overview
The Save on Memory Card feature provides the possibility to generate a memory card that can be 
used later for firmware (FW) update of another M340 PLC.
As an update with the memory card does not require the presence of Unity Loader, this option 
could be useful to update M340 PLCs that cannot be connected to the Unity Loader directly.
NOTE: The Save on Memory Card feature is only possible for M340 hardware platforms.
NOTE: If Unity Loader is connected to another device than a M340 PLC the check box 
Save on Memory Card is disabled and the text is changed to No Memory Card.

Save on Memory Card Unchecked
By default Save on Memory Card is unchecked.
The Unity Loader sends a request to update the PLC immediately after the firmware (FW) is 
transferred to the memory card.
The FW files are stored only temporarily on the memory card and are removed after the update is 
completed.

Save on Memory Card Checked
If Save on Memory Card is checked, the unzipped firmware (FW) files are transferred to the 
memory card of the PLC.
The files are marked for automatic update.
At the end of the transfer, you are asked to perform a manual reset of the PLC.
A reset updates the FW of the PLC automatically, if the current version of the PLC is earlier than 
the version on the memory card and the FW on the memory card is compatible to FW on the PLC.
After the update, the files related to the FW are then removed from the memory card.
NOTE: As it is not possible to display the data on the memory card, it is recommended to label the 
card after saving FW on the card.

Source/Target PLC
You can use a memory card for firmware (FW) update of another PLC.
 Source PLC

On the source PLC you generate a memory card, remove it from the PLC and send it to the 
target PLC (for example, to another site/country).

 Target PLC
On the target PLC, you insert the memory card and update the FW.

NOTE: The memory card must remain on the target PLC as long as the firmware update is in 
progress.
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Updating a PLC with Memory Card
To update the target PLC using the memory card, created at the source PLC, proceed as follows:

Only 1 FW on Memory Card
Only 1 firmware (FW) can be saved on a memory card.
Each transfer, whether Save on Memory Card is checked or not, erases the FW folder first.

Memory Card Write Protect
NOTE: If the memory card is write protected, it is not possible to perform an update using the 
memory card.

Addressing Modules
For addressing modules (with firmware), please refer to Addressing Modules (see page 34).

Project on Memory Card
If there is a memory card present on a Modicon M340 or M580 and you transfer data using the 
Project tab of the Unity Loader, the following data are stored on the memory card for backup 
reasons:
 Project (Control Expert application)
 Project Files
 Data Storage files
 User Web Files 

NOTE: Other user files (like Word, Excel, Adobe) and Project Data (%M, %MW, values of 
unlocated data) are not stored on the memory card.

Step Action
1 Check Save on Memory Card and start the transfer.

Result: 
 The unzipped firmware (FW) files are transferred to the memory card of the PLC.
 The files are marked for automatic update.

2 Remove the memory card from the source PLC.
3 Insert the memory card to the target PLC.
4 Perform a manual reset at the target PLC.

Result:
 The firmware (FW) of the target PLC is updated automatically if the current version of the PLC 

is earlier than the version on the memory card and the FW on the memory card is compatible 
to FW on the PLC.

NOTE: 
The files on the memory card related to FW are removed after the update.
NOTE: 
The memory card must remain on the target PLC.
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Project and FW at Once
If you transferred data to a memory card (on the Project tab) as described above and you are using 
the Save on Memory Card feature on the Firmware tab, both data are present at the memory card.
NOTE: It is also possible to update a project only without updating the firmware (FW).
Inserting the memory card into another PLC and performing a manual reset, the project, and the 
FW are updated.
The memory card must remain on the target PLC.
NOTE: Take care to have the appropriate project on the memory card.

One Shot/Multi Shot
For using the memory card there are 2 modes:
 One shot

With the one-shot mode, you need 1 memory card for 1 update.
 Multi-shot

With the multi-shot mode, you can use a memory card, generated on a source PLC, to update 
several target PLCs (for Control Expert applications only).

For the possible use cases of the memory card, please refer to this table:

Area Description One Shot Multi-Shot
System Area
(Firmware tab)

1 firmware (FW) (including 
WEB pages if available)

Need 1 memory card per FW and 
per machine.

not supported
(The system removes the 
update information after 
the update is completed.)

User´s Area
(Project tab)

Project (Control Expert 
application)

No need to provoke a backup, 
the new memory card remains in 
the PLC.

You need to provoke a 
backup.

Data Storage files The new memory card remains in 
the PLC.

not supported
User Web Files 
other user files (like Word, 
Excel, Adobe) 
Project Data (%M, %MW, 
unlocated data)

not supported not supported
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Options Tab

Overview
The Options tab comprises a set of general settings for the Unity Loader.

Representation
Options tab
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Settings

Transfer Button
In the Options tab the Transfer button is disabled.

Element Description
Default backup 
directory:

backup directory for Unity Loader files (e.g. C:\Applications)
The default backup directory and the project name on the PLC are used to 
generate new project names (including path) automatically while 
transferring a project from PLC to PC (see page 28).

FTP log file: name and path of the FTP log file
In this file, requests and replies exchanged between the loader´s FTP 
client and the PLC´s FTP server are logged.
Click the View button to look at the log file.
Click the Clear button to empty the log file.

Event log file: name and path of the event log file
In this file, the major events, such as FW transfer, PLC start / stop or 
unexpected events are logged.
Click the View button to look at the log file.
Click the Clear button to empty the log file.

Language: This list box displays the languages provided for the Unity Loader user 
interface.
 English
 French
 German
 Italian
 Spanish
 Chinese

To switch to another language click the arrow and select the respective 
language in the list.
Note: After switching to another language you have to close and launch 
again the Unity Loader.

TCP/IP / 
UNTLW / 
Modbus 
transmission 
timeout:

delay used for self-recovery while TCP/IP / UNTLW / Modbus transmission 
(seconds)
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About Tab

Overview
The About tab comprises information about your Unity Loader:
 version
 build
 copyright information
 license agreement

Representation
Unity Loader is a free tool which runs without registration.
About tab
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License Agreement
Click the License agreement button to display the license agreement for your Unity Loader 
software.

Transfer Button
In the About tab the Transfer button is disabled.
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Scan Network Dialog Box

Overview
Clicking the Scan... button opens this dialog box.
Network scanning helps you to detect IP addresses of Modicon M340, M580, and Momentum 
PLCs in the network.
The Scan Network dialog box is modeless, that is, the dialog box does not keep the input focus so 
scanning can be done in parallel.

Representation
Scan Network dialog box

IP Range
Specify the range of IP addresses, in which the hosts are searched after clicking the Start scan 
button. You can also click the auto-detect button ( ). to fill in the maximum range of the PC´s 
network segment.
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IP Address Properties
The IP Address properties comprise the following elements:

Command Buttons
The text of some buttons changes depending on the actual situation (for example, Start Scan / 
Cancel Scan). Grayed buttons are disabled.
The command buttons area comprises the following buttons:

If the Unity Loader is connected the Pick address button is disabled.

Element Description
IP Address IP address found in the network
Host Name host name of the found IP address
MAC Address MAC address of the found IP address
devices device assigned to the found IP address

Button Description
Start scan / 
Cancel scan

Click this button to start/cancel network scan.
The status of the scan process is displayed above the command buttons.

Pick address Click this button to fill the IP address of a selected host into the address box 
of the main dialog box. See Connection (see page 21) .

Close Click this button to close the Scan Network dialog box.
44 33003805 12/2018



Unity Loader Dialog Box
Transferring Data Dialog Box

Overview
Clicking the Transfer button opens this dialog box.
The Transferring data dialog box displays a status report of the data transfer.
The dialog box is modal, i.e. you cannot return to the previous dialog box until the Transferring data 
dialog box is closed.

WARNING
UNINTENDED EQUIPMENT OPERATION
Before transferring data to a PLC or to a module with firmware make sure that you have selected 
the correct project and firmware files and entered the correct target address. Verify the address 
by comparing the MAC address printed on the device with the MAC address shown in the 
Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT BEHAVIOR
If the transfer of data failed (for example, a PLC power off occurs during the transfer), the PLC is 
in an undetermined state. In this case restart the transfer immediately.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Representation
Transferring data dialog box
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Status Information
For application transfer the Transferring data dialog box comprises the following status 
information:
 transfer started
 number of bytes transferred
 transfer completed
A status bar displays the transfer status.
For firmware (FW) transfer the Transferring data dialog box comprises the following status 
information:
 transfer started
 free space on memory card
 required space
 available space
 directory information
 transfer completed
 writing files to flash memory
 FW update successful
A status bar displays the transfer status.
NOTE: The Transferring data dialog comprises only the main events. For detailed information 
please refer to the log files in the Options tab (see page 39).

Required Space
The amount of required space is a little bit larger than the data that should be transferred, because 
the firmware (FW) needs additional space for file management.

Available Space
The value of available space may be larger than the Free Space value displayed in the Memory 
Card status line because the calculation of available space takes into account the memory space 
of data that will be overwritten by new data.

Command Buttons
Grayed buttons are disabled.

NOTE: During firmware (FW) transfer the Abort and the Close buttons are disabled.

Button Description
Abort Click this button to abort the transfer.
Close Click this button to close the Transferring data dialog box.
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Chapter 4
Example: Transfer of an Application from PC to PLC

Transfer of an Application from PC to PLC 

Procedure
The following table describes the procedure for transferring a Control Expert application from a PC 
to a Modicon M340, M580, Momentum, Premium or Quantum PLC.

Step Action
1 Connect the PC and the PLC to the network.
2 If you do not know the required IP addresses click the Scan... button. (See Scan Network Dialog 

Box (see page 43)).
3 Enter the connection data: Media and Address. (See Connection (see page 21)).
4 Click the Connect button. (See Command Buttons (see page 23)).
5 Select the required project files (PC Project, PC Project Data, PC Project Files). (See PC Project 

Properties (see page 26)).
6 Set/reset the required Enable Transfer check boxes. (See Enable Transfer (Check Boxes) 

(see page 27)).
7 If necessary set the transfer direction to PC->PLC by clicking the PC<=>PLC button. (See 

Command Buttons (see page 23)) and Transfer Signs (Arrows) (see page 28)).

WARNING
UNINTENDED EQUIPMENT OPERATION
Before stopping the PLC, make sure that you are connected to the correct target address. Verify 
the address by comparing the MAC address printed on the device with the MAC address shown 
in the Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

8 Click the Stop PLC button. (See Command Buttons (see page 23)).
9 Click the Transfer button. (See Command Buttons (see page 23)).

Result: The Transferring data dialog box opens and displays a status report of the data transfer. 
(See Transferring Data Dialog Box (see page 45)).

10 After transfer is completed, close the Transferring data dialog box and click the Start PLC button
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Appendix A
Transfer of Applications in Batch Mode

Batch Mode with the Unity Loader Command Line Interface

Overview
The Unity Loader offers the command line interfaces UlUmas.exe for skilled users.
UlUmas.exe provides commands for transferring applications and data files via UMAS protocol.
The main usage is to transfer applications to one or several PLCs by calling a script without running 
Unity Loader dialogs but you can also start and stop PLCs.
NOTE: This command line interface can only be used if the PLC is not protected with an application 
password.

Commands without Additional Checks
The command line interface executes commands on the PLC without additional checks.

Transfer Project

WARNING
UNINTENDED EQUIPMENT OPERATION
Before executing commands by means of the command line interface make sure that the 
commands will not result in unintended situations for men or equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Before transferring data to a PLC make sure that you have selected the correct files and entered 
the correct target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown by Unity Loader in the Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Start PLC / Stop PLC

UMAS
UMAS stands for Unified Messaging Application Service, a platform independent protocol for 
exchanging application data.

Program
You can find the UlUmas.exe in the installation directory of your Unity Loader software.

Invocation
UlUmas[.exe] [-a:Address] [-s:ScriptFile] [-l:LogFile],

where:
 Address: IP-Address or host name. For a USB connection, use the reserved IP address 

90.0.0.1. Alternatively, you can specify the IP address with the Open command.
 ScriptFile: name of script file containing the UMAS commands
 LogFile: name of log file containing the status messages

An example:
UlUmas -s:RunMyApplication

WARNING
UNINTENDED EQUIPMENT OPERATION
Before starting/stopping a PLC make sure that you are connected to the correct target address. 
Verify the address by comparing the MAC address printed on the device with the MAC address 
shown in the Firmware tab.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Evaluate operational state of equipment before starting or stopping a PLC.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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List of Commands

NOTICE
UNINTENDED STOPPING OF THE PLC
Before using the D1App command make sure that you are connected to the correct target 
address.
Verify the address by comparing the MAC address printed on the device with the MAC address 
shown in the Firmware tab.
Failure to follow these instructions can result in equipment damage.

Command Description
Open <IP Address> connects to the UMAS server on the PLC with the specified IP Address
Close terminates the current UMAS session
D1App <Application 
File>

downloads application file
The application file can have one of the following extensions:
 STU file, a project file saved with Control Expert.
 STA file, an archive file generated with Control Expert or with Unity Loader.
 STM file, an archive file without upload information, generated with Unity 

Loader.
NOTE: This command automatically stops the PLC.

U1App <Application 
File>

uploads application file
The application file can be:
 STA file

An archive file generated by Unity Loader, that can be read with 
Control Expert.
NOTE: The application is generated in Control Expert with the Upload 
information selected.

 STM file
A backup file generated by Unity Loader, which cannot be read with 
Control Expert.
Use this file type, if the application was generated without upload information.

D1Dat <DataFile> downloads user data file
DataFile: file containing snapshot values of an application, uploaded with Unity 
Loader or Control Expert.

U1Dat <DataFile> uploads user data file
DataFile: file generated by Unity Loader containing the current application 
values.

Run puts the PLC in the RUN mode
Stop stops the PLC
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Script File
Each line of a script may contain either a single command or a comment.
A comment line starts with #.

Parameters are specified as environment variables by starting and ending with %.

Example script for transferring an application to several PLCs:
# store these lines to a file named "TransferApp.txt" and

# call UlUmas -s:TransferApp.txt

# open first PLC

Open 192.168.10.1

# make a backup first

UlApp BackupStationV1.sta

# download new application generated by Control Expert,

# the PLC has to be in stop mode

Mirror [size] tests the UMAS connection by sending an arbitrary stream of data, which is sent 
back by the UMAS server. If the response differs from the request, a detected 
error is reported.
Size (length of data):
 minimum = 1 byte
 maximum <= 1022 bytes

NOTE: Depending on the network configuration, the maximum maybe 
smaller. 

PlcInf retrieves information about current application, PLC and memory card
AppInf retrieves information about current application
DatInf retrieves information about current application located and unlocated data

CompDat
<RefDataFile>
<CompDataFile>

compares variable values of an application stored in a reference data file with 
either:
 PLC values 
 values stored in a data file

Bye terminates UlUmas.exe
! [WindowsCmd] runs a Windows Command

If the command is omitted, a Windows Command shell is opened, which has to 
be terminated with the Windows Exit command.

? displays the command list

Command Description
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Stop

DlApp StationV2.stu

Run

Close

# open second PLC, this time the IP address is specified as

# an environment variable

# in the Windows command shell type 

# Set BMX2020_2=192.168.10.2 
Open %BMX2020_2%

Stop

DlApp StationV2.stu

Run

Close

# open third PLC, this time a host name is used as address

# edit the WINDOWS\system32\drivers\etc\host and enter the

# line

# 192.168.10.3 Bmx2020_3

Open Bmx2020_3

Stop

DlApp StationV2.stu

Run

# terminate UlUmas.exe

bye
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networks, 23, 43
settings, 39
starting

PLC, 19, 54
stopping
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